Capture bibliographic references from online databases
Build your personal library of references

Share your library of references with colleagues
Generate bibliographies in any style of your choice
Manage in-text citations as you write your paper







GETTING STARTED WITH ENDNOTE WEB

REGISTERING FOR AN ENDNOTE WEB ACCOUNT

If you have not used EndNote Web before go to www.myendnoteweb.com and click on the
Sign Up link. If you are not on campus sign up via institutional login to set up an account.

New to EndNote Web?| Sign Up fpr an account

Enter vour e-mail address and password here:

E-mail Address: |

Fassword:

Log-In

™ keep me logged in on this computer unlass 1 log aut,

Forgot Your Password? Problems Logging-In?

The sign up process is simple but be aware that your password must be at least 8 characters
long and must contain at least one letter, one number and one special character (e.g. !)

If you are already registered with the Web of Knowledge you can use the same password to

access EndNote Web.

YOUR ENDNOTE WEB

Once you sign in you will be taken to the main EndNote Web interface which has the following

features:

EndNole"™

provided by IS] Web of Knowledge™

Navigational tabs

v

[Unfiled] (27}
GQuick List {0}
Trash (0} A

P My Groups

My References Collect Organize Format Options
Quick Search All My References
|Search for h
inl all My References FaClIlty to qU|Ck|y
(Search ) I search your EndNote 1 < Page [ of3 (G
My References Web I|brary
All My References {52 | ™

_— Can Page IAdd to group.. vl [ Copy to Quick List | { Delete ]

Authort Year

Title

Panel containing a summary of
your EndNote Web library

bramowitz, 1. S. 2010

<untitleds>
Added to Library: 17 Feb 2011 Last Upd

B [gm S|

Obsessional thoughts and compulsive
symptoms

Arch Womens Ment Health

Added to Library: 17 Feb 2011 Last Upd

[ W=y
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CAPTURING REFERENCES

DIRECT CAPTURE FROM WITHIN ENDNOTE WEB

You can add references from within EndNote Web using the Online Search feature within the

Collect tab.
My References Collect Organize
Online Search Mew Reference Import References

Online Search
Step 1

Select database or library catalog connection.

ESelect,, i+| Select Favorites

British Library

Imperial Coll Sci Tech Med
Kings College Londan
Library of Congress

Matl Lib of Medicine
Project MUSE

PubMed [MLM)

Gueen Mary U of Landan
U London

wiellcorne Trust

If you are looking for an article reference select an
appropriate database from the drop down box and click
Select.

If you are looking for a book reference it would normally be
advisable to select the British Library catalogue and then
click Select.

In the search screen which opens you should enter brief
keywords to identify the item that you are looking for.

You can use the drop down boxes
to search different fields, e.g. author
or title.

Click on Search.

When the results are displayed
select the one(s) you wish to add to
your library

Online Search

Step 2 of 3: Connecting to British Library @ Library Catalogue

Icrossrnan in: IAuthor ;I Iﬁmd;l
Ineuroanatorn,- in: ITitIe ;I Iﬁmd;l
| int  |any Field =] [and =]
| in:  [any Field =]

* retrieve all records
T celect a range of records to retrieve

Search

Then use the Add to group drop down box to add them.
Select unfiled if you haven’t made any groups yet.

v

I oal T Page fAddto group... |

Author Ye ”:' =ML
= aw
[Unfiled] )
W Crossman, 201 Hew group anatamy @ an illustrated colour text

&R,

| gm & sfx

DIRECT EXPORT FROM THE WEB OF KNOWLEDGE
The Web of Knowledge has a special export button enabling you to send references directly to

EndNote Web.

1. Perform a search and choose the references

. Print { E-mail | { Add to Marked List Save 1o EndNnIeJWeb yOU’d Ilke tO add tO EndNOte Web USIng the

check boxes.

Authoris): Bassareo ¥, Musio P, Di Chiara G

Times Cited: 0

Times Cited: 0

¥ 1. Title: Recipracal respansiveness of nucleus accumbens sh

Source: PSYCHOPHARMACOLOGY “olume: 214 Issue: 3

2. Click on Save to EndNote Web.

3. If you are not signed in to EndNote Web you

¥ 2. Tie:iability of Lactobacillus acidophilus LA 5 and iide|  Will D€ @sked to do so.
Authoris): Ozcan T, Yilmaz-Ersan L, Akpinar-Bayizit &, et al.
Source: MLJEKARSTVO volume: 60 Issue:2 Pages: 135-

The references will be transferred directly to your
EndNote Web library.
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IMPORTING REFERENCES FROM A SAVED FILE

Some databases require you to save your results as a text file
and then import this text file to EndNote Web. For example using

PubMed:

1. Perform a search in the usual way and select the

results you wish to save in EndNote Web.

2. Then use the Send to drop down box. Choose

Citation manager.

3. Click on Create File and save the results.

/

Send to: Filters: tanage Fi

Choose Destination

 File  Clipboard
|  Collections  E-mail
T Order = My Bibliography

& Citation manager

Generate a file for use with external citation
management software.

Dowenload 1 citation.

Create File

—

asthma exacerhati

These results then need to be imported to EndNote Web. Do this by clicking on the Collect tab,

then on Import References.

Import References

Irporting from EndMote?

File: |Gy Du:-cuments'l.D-:-wnlc-ads'l.citati-:-n

Import Option: | PubMed (HLM) v
To: | [Unfiled] W
. Import )

Select Favorites

CAPTURING WEB PAGE REFERENCES

1. Browse for the file you have just saved

2. Choose the Import Option
corresponding to the source of the
references

3. Select where you wish the references
to be saved then click on Import

The references will then appear in your
EndNote Web library.

In order to capture references straight from the web you can drag the Capture Reference
button to the bookmarks bar in your browser. Get this from the Download Installers page

under the Options tab.

My References Collect Organize

Passward | E-mail Address | Profile Infarmation

Language

Format

Options

Download Installers | Account Infarmation

Download Installers

Web Capture:

Capture Reference

To install the web Capture tool, just drag the
browsers, you may need to right-click and se
To use it, browse to a page you like and click
instructions in the window.

Please note that it is sometimes necessary
to manually modify some of the reference
details in the Capture New Reference
window before saving to EndNote Web.

ENTERING REFERENCES MANUALLY

Capture New Reference
 Save to |

Bibliographic Fields | Optional Fields

Groups: Add or remaove
Bibliographic At least one of the fields must be filled out,
Fields:

Feferance Type:

% EndMote web © Endhote

Publisher:

volume: |

IJournaI Article ;I

Author: IDepartment of Health

Use format Last Mame, First name, Enter 2ach name on a
new line,

Title:

INew online tool to search and compare local care proy

Year: |zoiz

Journal: |

IDepartment of Health, Richrmond House, 79 wWhitehal
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A very last resort, when you cannot find a reference in an electronic format, is to enter it

manually.

Firstly click on Collect then select New Reference. A blank form will open where you can fill in

as many fields as you wish.

Mew Reference

Bibliographic

Fields: Cance!

Reference Type: | web Page =

Authar: :
Lse format Last Mame, First name.

Title:

Year:

Remember to select the reference type
from the drop down box before you begin.

Be careful to follow the instructions about
entering authors’ names.

Institutional authors should be followed by
a comma, for example: Department of
Health,

Ensure your reference is saved before navigating away from this page.

MANAGING YOUR REFERENCES IN ENDNOTE WEB

Within EndNote Web it is very easy to organise your references into groups rather like with any
webmail application. Click on the Organize tab and select Manage My Groups.

My References Collect

Manage My Groups Others' Groups

Organize

Find Duplicates

Format

Manage My Groups

. Number of !
My Groups+ ' References Share
Project 1 4O
Research 5 -
_ New Group |

Manage Sharing |
Manage Sharing |

Rename | | [ pelete |

Rename Delete |

From this screen you can create new groups or delete existing groups.

If you wish to share a group of references with a colleague who has an EndNote Web account
you can select the group and click on Manage Sharing. You will be asked to enter your
colleague’s email address and then they will also be able to access this group.

When you wish to add references to groups you use the Add to group drop-down box in the
same way as described under DIRECT CAPTURE FROM WITHIN ENDNOTE WEB. Select the
references you wish to add, then from the drop-down box select the group you wish them to be

added to.
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USING YOUR ENDNOTE WEB REFERENCES

CREATING INDEPENDENT BIBLIOGRAPHIES

You may wish to create a standalone list of the references you are using, for example to share
with a colleague. This can be done by clicking on the Format tab and selecting Bibliography.

Bibliograph
graphy 1. Select the group of references
References: |- Research = to be included in the bibliography
Bibliographic style: [Harvard UL =l 2 choose the bibliographic style
File format: |RTF (rich text file) =] you would like to use
save ) ( E-Mail ) ( Preview & Prin{ 3 Save the document in the RTF

format

This new document will be compatible with Microsoft Word.

CITE-WHILE-YOU-WRITE

EndNote Web can revolutionise the way you write a paper. The Cite White You Write toolbar
for Microsoft Word makes inserting citations into your text and building a bibliography simple.

You have to download a plug-in for Microsoft Word which will add a new toolbar to this
application. Do this by selecting the Format tab and clicking on Cite-While-You-Write.

ol
—/ Home Insert Page Layout References Mailings Review View EndMote Web

@ EN ’] Style: | AAG Style Guide
g Web

- *[ Export to EndMote Web ~

=7 Update Citations and Bibliography \{1_’] Preference

Find Goto Edit

ations EndMote Web Citation|s) é Con Citations and Bibliography = | ‘? EndNote WeN 'Wg

Citations Bibliography

Find and insert citation(s)

(] Tools

Format Bibliography Cite While You

Write preferences

Once downloaded, the toolbar will automatically be integrated into Word for you. If this toolbar

is not available to you there is an alternative.

When writing your document in Microsoft Word, insert your citations in braces as shown in the

example and follow the instructions.

Chocolate contains a natural 'love drug' {Ross, 2007}
Tryptophan is a chemical that the brain uses to make a
neurotransmitter called serotonin. High levels of serotonin
can produce feelings of elation, even ecstasy - hence the
name of the designer drug that also works by increasing
serotonin levels.

While iryptophan could be considered ‘chocolate's
ecstasy’, another chemical called phenylethylaminge has

earned the nickname 'chocolate amphetamine.' [Parker,.

2002, Mood state effects of chocolate} High levels of this
neurotransmitter help promote feelings of attraction,
excitement, giddiness and apprehension.

Phenvlethylamine works by stimulating the brain's

pleasure centres and reaches peak levels during orgasm.

iMacht, 2006; Lee, 2001}

1. Give the author’s last name and
year, separated by a comma

2. Add a comma and part of the title
when your EndNote Web library
contains more than one reference
from the same author with the same
year

3. Use a semi-colon to separate

multiple references within the same
citation
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You should then save your document as a Rich Text Format (RTF) file.

Flename; cie doc 3
Save 85 LYPe | word Document (*,doc) |"*"T
——web Page (F.htmg ¥ Rkl -~

Web Page, Filkered {*.htm; *.hkml)
Diocument Template (. dot)

Rich Texk Format £, rEf)
Plain Text {*.bxt)

Waord "12" Document (*.doc W

To format this document, as well as change the bibliographic style of any standalone
bibliography you have created, click on the Format tab and select Format Paper.

Format Paper

For Rich Text Format documents (.rtf) {See a sample paper):

File: IE:'I."."\"mdnws WT 4.0 Workstation Profile  Browse.. |

Bibliographic style: |Harvard UL =| Select Favorites

™ ignore unmatched citations

_ Format ) ( Clear

1. Browse for your RTF file

2. Choose the bibliographic style you’d like to use and click on Format

Your document will now have formatted in-text citations as well as a bibliography of references
at the end.

FURTHER HELP

If you have any problems or need more help using EndNote Web go to the library’s EndNote Web
page at www.library.gmul.ac.uk/endnote/web where you’ll be able to find FAQs as well as our own
bite-size EndNote Web demos.
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